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Introduction 

The Cochrane Library is a suite of databases which will help you find reliable evidence about the effects 

of health care interventions. The database is freely available on the internet. It contains these 

databases: 

 Cochrane Reviews 

 Other Reviews 

 Clinical Trials 

 Methods Studies 

 Technology Assessments 

 Economic Evaluations 

 Cochrane Groups 

You will find out more about these individual databases later. 

Learning outcomes 

By the end of this workbook you should be able to: 

 Access the Cochrane Library  

 Know the difference between the databases in the Cochrane Library  

 Perform a variety of searches within the Cochrane Library 

 Combine search results 

 Display the results of your searches  

 Save, print or export your search results  

About this workbook 

Internet Explorer is the supported browser so this workbook assumes that you are using it.  



Skills@Library: Cochrane Library  Page 3 of 16 

26/04/2018                  http://library.leeds.ac.uk/downloads/clibwkbook.pdf 

1. Getting Started 

Throughout this workbook, you will learn how to use subject headings and keywords to find results to 

answer a particular question:  

"Can cognitive behavioural therapy help to improve self esteem in people with eating 

disorders?”  

While this might be outside of your subject field, the guided example will teach you the principles 

behind the literature searching process. You can then apply the same skills to search for articles on 

your own topics. 

a. Finding the Cochrane Library 

Exercise 1 

The Cochrane Library is freely available, so you can go there direct: http://www.thecochranelibrary.com  

You should now see the following screen: 

 

You do not have to log in to search the database, but if you log in you can use a personal account to 

save your search strategies. This means that you can return at a later date and re-run saved searches 

instead of typing in your search terms all over again. Another of the benefits of saving your search 

strategy is that any matching records that have been added to the database since the last time you ran 

your search will automatically be included with your latest results. 

http://www.thecochranelibrary.com/
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If you would like to set up a personal account, click on Advanced Search from the homepage, which is 

located under the search box on the top right hand side. From the Advanced Search screen, click on 

Log in/Register on the top right and follow the prompts. 

b. Understanding the databases in the Cochrane Library 

The Cochrane Library is made up of 7 databases: 

 Cochrane Reviews - Cochrane Database of Systematic Reviews 

 Other Reviews - Database of Abstracts of Reviews of Effect 

 Clinical Trials - Cochrane Central Register of Controlled Trials 

 Methods Studies - Cochrane Methodology Register 

 Technology Assessments - Health Technology Assessment Database 

 Economic Evaluations - NHS Economic Evaluation Database 

 Cochrane Groups - About The Cochrane Collaboration 

To find out about the different types of information each database provides and which ones are most 

relevant to you for a particular search, you can read their descriptions to find out the type of results 

(systematic reviews, clinical trials etc) each database offers. 

Exercise 2 

From the homepage, select the About drop down menu and click on ‘About the Cochrane Library’. 

 

Make a note of the databases you might find useful during your research. 

2. Breaking down your question 

To perform an effective search, you need to start by breaking down your research question into its main 

topics.  
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In this workbook we are looking for evidence to find out:  

"Can cognitive behavioural therapy help to improve self esteem in people with eating 

disorders?”  

In this case our main topics are:  

1. cognitive behavioural therapy  

2. self esteem  

3. eating disorders  

The other words in the research question do not need to be searched for. 

Here’s the process:  

1. First we will search for results about cognitive behavioural therapy  

2. Then we will search for results about self esteem  

3. Then we will search for results about eating disorders  

4. Finally, we will combine these 3 sets of results using AND. This will leave us with one set of 

results that contain all your topics together  

It is possible to just type the following into the database to find some simple results, but it won’t be a 

comprehensive search: 

cognitive behavioural therapy AND self esteem AND eating disorders 

In order to search comprehensively we will make use of both subject heading (MeSH) and keyword 

searches. 

3. Searching using subject headings 

Medical Subject Headings are items from the MeSH thesaurus published by the US National Library of 

Medicine. Headings are organised hierarchically and records found using subject headings will be 

about the chosen term (as opposed to material searched using keyword searching only, which may 

simply contain that word in the text).  

For example, if you search using the MeSH term Kidney Failure, Acute you can be assured that all of 

your results will be significantly about that topic regardless of the exact terminology used by the author 

in the document itself. 

Note - Not all databases in the Cochrane Library assign MeSH headings to their records so you cannot 

rely on searching by this method alone (you should also use keyword searching alongside it). 

For those of you who are familiar with using subject headings to search Medline, the Cochrane Library 

uses the same set of subject headings. This means your Medline search strategy can be easily 

replicated in the Cochrane Library. 
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Exercise 3 

First, click on Advanced search 

 

Now click on the Medical Terms (MeSH) tab:  

 

Let’s search for some records about our first concept, cognitive behavioural therapy. Type this into 

the search box and click Lookup to search. The database will now try to map that topic to the closest 

subject heading it has available. 

 

[As you start typing in your topic, the database may make some suggestions as you type, if a 

suggestion matches your search, click on it to select it] 

In this case it maps to the recognised subject heading Cognitive Therapy 
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The layout of the MeSH terms in a tree shows how different terms are related to each other, for 

example Cognitive Therapy is a narrower term within the broader topic of Behavior Therapy. 

Sometimes the heading will have narrower topics, indicated by a number in square brackets such as 

[+2], each with extra results that you may want to include. In this case our topic Cognitive Therapy has 

2 narrower topics within it: Mindfulness and Acceptance and Commitment Therapy. To include 

these topics you need to choose to explode your subject heading, which will retrieve all the records on 

that topic, and retrieve all the extra articles about the narrower topics as well. 

Note: The database will automatically explode your term for you unless you deselect and click Single 

MeSH term (unexploded) instead. Sometimes your term may appear in more than one tree, hence the 

options to Explode all/selected trees. 

Click on View results. Then scroll down to view the results found in each database (note the results 

are separated into the seven databases which make up Cochrane) 

IMPORTANT: now scroll back up and click on Add to Search Manager as shown circled in the image 

above. This will allow us to use this search later when we come to combine it with our other searches. 

Now follow exactly the same process for the other two concepts in our example research question: 

Self esteem (this will find the subject heading self concept) 

Eating disorders (this will find the subject heading feeding and eating disorders) 

Remember to also add these searches to the Search Manager so we can use them again later. 



Skills@Library: Cochrane Library  Page 8 of 16 

26/04/2018                  http://library.leeds.ac.uk/downloads/clibwkbook.pdf 

4. Searching with keywords 

Subject heading searches will probably find you many of the relevant papers, but for a comprehensive 

search you need to supplement your subject heading searches with some keyword searches.  

Searching by keyword enables you to type in a word or phrase and the database will bring back any 

references where there is a match (or very similar word/meaning) in the article’s record.  

Note: The Cochrane Library search has an Auto-suggest feature. This will automatically look for some 

obvious variants of your search term e.g. searching for the word clear will find clear but also clears, 

cleared, clearing etc. Some spelling variations will also be detected e.g. tumour will also retrieve 

tumor. In this workbook however, we’re going to override this feature by using the truncation method 

when we search, which allows us to control which variations will be searched for. 

You will need to make a judgement about how far you try to define the concepts you are interested in – 

this often depends on why you are carrying out the search. Under some circumstances it may be 

appropriate to stick to one major way of defining a concept, but if you’re trying to be more 

comprehensive you should aim to think of and include as many synonyms as possible. 

Spend a few moments thinking about the different ways our concepts could be referred to in the 

literature and list them below. Consider any alternative spellings (American versus English), plurals and 

abbreviations. 

How else might cognitive behavioural therapy, self esteem and eating disorders be referred to? 

Include even slight variations – otherwise your search results will exclude them.  

How many can you think of? List them here: 

TOPIC 1 – cognitive 

behavioural therapy 

TOPIC 2 – self esteem TOPIC  3 – eating disorders 

? ? ? 

? ? ? 

? ? ? 

? ? ? 

Now see whether you can make use of any of the following search techniques to help you search more 

efficiently and comprehensively: 

a. Truncation 

Using * overrides the auto-suggest feature and may help you to more fully understand the terms that 

will be used in your search.  
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The symbol is most commonly used at the end of a word to look for variant endings, but in this 

database * can also be used within a word to look for alternative spellings e.g. an*esthetics will 

retrieve both anesthetics and anaesthetics.  

In addition it can be used at the beginning of a word to match terms with the same suffix.  *glycemia 

finds hyperglycemia or hypoglycemia. 

b. Phrase searching 

For an exact phrase search, enter your terms in inverted commas e.g. “cigarette smoking”. However, 

if you want to be more flexible, use the NEXT operator i.e. cigarette NEXT smoking. Your search 

terms will appear next to each other but because of the auto-suggest feature the database will retrieve 

similar matches as well – for example ‘…the number of cigarettes smoked…’ 

c. Proximity searching 

Known in some other databases as adjacency searching, connecting your search terms with NEAR and 

a number allows you to search for those words close to (but not necessarily right next to) each other in 

the text and in either order.  

For example: cigarette NEAR/3 smoking 

This will allow up to 3 words to occur in between your search terms. If you don’t state a number, the 

database will automatically apply the number 6. 

 

To see more information about the Cochrane Library’s search features and tips, click the Search Help 

link below the search box. 

Exercise 4 

Now it is time to enter your words and phrases, one concept at a time, into the database.  

Decide which fields you want to search (all text/title, abstract, keywords etc) and make your selection 

from the drop down menu. 

The easiest way to do this is to go to the Advanced search screen by clicking on the Search tab.  

You can type in more than one search term for each concept in the same line, combining them with 

OR, like this: 
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This method is more convenient than running a series of individual searches as you will see when we 

come to combine them at the end. 

Click on Go to see your results and remember to click on Add to Search Manager so we can use this 

search again later. 

Exercise 5 

Now do exactly the same for your cognitive behavioural therapy concept, combining with OR if you type 

more than one search term into the same line. Add the search to the Search Manager. 

Exercise 6 

Finally, do the same for eating disorders and its synonyms. Combine these using OR and add to the 

Search Manager. 

Note: to add another line to your search click on the  icon after the previous line. 

5. Combining your search results 

Now that you know how to find some articles, you need to know how to combine your search results to 

be left with one final set of papers that contain all your concepts together.  

Exercise 7 

Click on the Search Manager tab to see every search you have carried out so far. 

Identify the searches (both subject heading and keywords) you carried out about self esteem,  type a 

hash symbol followed by the first set number, then type the word OR, then another hash symbol and 

the other set number and continue for all of the set numbers which correspond with your first concept, 

as shown below: 
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Click on Go to create a combination set, all about our first concept. 

Do the same for the cognitive therapy concept (in this case type #2 or #5 or #6 or #7) and click on Go 

Finally, do the same for eating disorders concept (type #3 or #8 or #9) and click on Go 

The final stage is to combine your combination sets!  

To do this, just identify your three combination sets – but this time combine them with AND. 

Type #10 and #11 and #12 and click on Go  

This narrows the search to leave you with one final set of results that contains all your topics together 

now as shown below: 

  

Click here to view your final results 

  



Skills@Library: Cochrane Library  Page 12 of 16 

26/04/2018                  http://library.leeds.ac.uk/downloads/clibwkbook.pdf 

6. Displaying your search results 

When you carry out a search in the Cochrane Library, the records from all the databases are searched 

simultaneously, but the results will be divided by resource. The total number of results in all Cochrane 

databases is shown under All Results. But the first results you see will be shown from Cochrane 

Reviews database. To view results matching your search from other databases, click the button next to 

the one database from the menu on the left.  

  

To view a fuller record for each result, click on its title. It will open in a new window or new tab. Just 

close it to return to your main list of results. 

A typical record from Cochrane Reviews will look like this: 

Below is a typical record from the Trials database. Full text is not available for these records inside the 

The online version of the paper will 

be shown. Cochrane Reviews are 

available to download as PDFs. Click 

the button here to get options of 

summary, standard or full PDFs. 
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database itself – you need to look at the Source field to see where the full text has been published. 

Then you need to search for that journal title in the Leeds library catalogue (search@library) to see if 

we have full text access to it.

 

Note – the Cochrane Library does not highlight your search terms in the records so it can be very 

difficult to see where your terms appear. (Hint: using Control + F on your keyboard or Edit> Find on 

your internet browser allows you to search for every occurrence of a chosen word – use this to see 

where your term(s) appear). 

7. Author search 

If you wish to search for documents written by specific authors, make sure you limit your search to 

Author using the drop down box. Use the format: “perrin n” 
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8. Browsing the database 

You do not have to enter a search term to view documents in The Cochrane Library and can browse 

the library by common topics or review groups. 

Click on the logo to return to the Cochrane Library homepage.  

 

Scroll down from the Cochrane Library homepage and you should see the option to browse systematic 

reviews by topic: 

 

You can also select to browse by Cochrane Review Group. 
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9. Printing, saving, sharing and exporting your results (including 

exporting to Endnote) 

Printing: Some documents have a PDF version which you can print out – there will be a PDF button to 

the left of the full record. Where this is not available, you can use your browser’s print function 

(File>Print) but be aware that some systematic reviews can be very long (over 60 pages). 

Saving a document: Where full text is available for your results (e.g. from the Cochrane Reviews 

database) you can save the PDF to a drive of your choice. If a PDF is not available, you have the 

option to save the record of information about the document (see section on exporting). 

Saving your search strategy: You can only do this if you are logged in to your personal account (see 

section 2). When you have performed a search, you can then save the strategy by clicking on the Save 

or Save Strategy button circled in red (depending on which search screen you are using) and follow the 

prompts. When you want to re-run that saved search, log in to your personal account and re-run the 

appropriate search.  

Sharing your search strategy: (for example with the library or other researchers) 

1. Once you’ve saved your search, click on Strategy Library at the bottom of the page. 

2. Then click on the Share icon and click ‘send link via email’. Enter the email of the person/people 

you want to share your search strategy with, and then click send.  

 

Exporting to EndNote:  

From the page on which your results are displayed, select the results you want to export to Endnote by 

clicking on the box next to the reference on the left hand side so a tick appears. 

1. Click on Export Selected either at the top or bottom of the page, or if you want to export all of 

your results, click on Export all. 



Skills@Library: Cochrane Library  Page 16 of 16 

26/04/2018                  http://library.leeds.ac.uk/downloads/clibwkbook.pdf 

2. You will then be prompted to Choose your export options. Select Export type: PC [if using a 

University desktop computer] and File type: Citation and Abstract. Then click on Export 

Citation.  

3. This will generate a .txt file containing your selected references. When asked: Do you want to 

open or save citation-export.txt from onlinelibrary.wiley.com? (which will appear at the bottom of 

your screen) click on Save. This file will then be saved to your Downloads folder on your Mdrive. 

4. You then need to import this file into Endnote. To do this, go into your Endnote library and click 

on File > Import > File. Then in the dialogue box click on Choose and navigate to your .txt file 

on your Mdrive (usually in your Downloads folder).  

5. Once you have selected your .txt file, click on the arrow on the drop down menu next to Import 

Option, click on Other filters, and then select the filter for Cochrane Library (Wiley), select 

Choose, and then Import. This will import your references into Endnote.  

For more help with using EndNote, see our Endnote support webpages: 

https://library.leeds.ac.uk/info/1403/endnote/43/endnote_support 

10. Advice on preparing a Cochrane review 

Information is available inside the database for anyone intending to prepare a Cochrane review. 

The information is available under Help, on the Cochrane Library homepage:   

  

or direct to http://www.cochranelibrary.com/help/how-to-prepare-a-cochrane-review.html. 

It explains about contacting the relevant Cochrane Review group for support, information about editorial 

processes and deadlines and provides links to resources including the Cochrane Handbook for 

Systematic Reviews of Interventions (available direct at http://training.cochrane.org/handbook). 

https://library.leeds.ac.uk/info/1403/endnote/43/endnote_support
http://www.cochranelibrary.com/help/how-to-prepare-a-cochrane-review.html
http://training.cochrane.org/handbook
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